MLA Formatting (8th ed.)
Basic MLA Format

1. Font is Times New Roman, pt. 12
2. Line Spacing is 2.0 or Double
3. Remove spacing after paragraph
4. 1-inch margins default
1. Insert → Page Number → Top of Page → Plain Number 3

2. Type Student's Last Name on the left side of the page number

3. Make sure the font is still Times New Roman, pt. 12
1. Left Justified, no indent
2. Double Spaced
3. Student’s First and Last Name
4. Instructor’s Name
5. Course Title
6. Paper’s Due Date
   (Day Month Year)
7. Center Justified, no indent
8. Title, no bold/italics/underline
There are three ways to set your indentations, either using the Paragraph Settings, using the Ruler, or using the Tab key.

**Using the Paragraph Settings**

**Using the Ruler**

**Tab Key:**
At the start of each paragraph, press Tab
Indentations: Step-by-Step Instructions

**Paragraph Settings**

1. Set your cursor on the line directly beneath the Title, justified to the left.
2. On the Home Tab, locate the Paragraph Box and then click the small icon in the very most bottom, right corner.
3. After the Paragraph Settings Box appears, find the Indentation Section. Then click the drop down labeled Special. Then click First Line.
4. Beside Special, in the box labeled By, set the indent to 0.5”.
5. Click OK to set the Indent.

**Ruler**

1. Set your cursor on the line directly beneath the Title, justified to the left.
2. On the View tab, locate the Show Box and check the box beside Ruler.
3. Now a Ruler has appeared along the top and left side of the document.
4. On the top ruler, click the upper triangle of the hourglass-like icon between the grey and white sections.
5. Drag the upper Triangle to right until it rests on the 4th measurement marker.
In-Text Citations

Each of your in-text citations will correspond to an entry in your Works Cited page.

Example:
- **In-text:** Legal scholar Jay Kesan states, "..." (312).
- **Citation:** Kesan, Jay. “Cyber-Working or Cyber Shrinking? A First Principles Examination of Electronic Privacy in the Workplace.” *Florida Law Review*, vol. 54, no. 2, 2002, pp. 289-332.

All outside information that you bring to your paper needs to have a citation. Depending on how the information appears in your paper, the way you format your in-text citations will change.

Author's Name In-Text

Introduce the author or source before quoting them. After your quote ends, but before your period, include the page number of the citation (if available). Ex: into a wider idea" (4).

example, if you are writing a paper about politics, imagine that the paper will be read by people in government. Similarly, if your paper is about a book or a historical figure, imagine that your reader will be someone who has a passing understanding of the subject. Your word choice should be natural to your own voice as well as suitably approachable and appropriate for your intended audience (Hacker 212). Try to avoid inflated language, or using fancier words than you usually use in order to sound more authoritative or intelligent. Most of the time, inflated language sounds unnatural. If you are unsure what kind of tone to use, pretend that you are explaining the topic to an older person who you do not know too well. By using these strategies, your paper can be

Paraphrased

seems immediately relevant to you may appear random and misplaced to your reader. In order to ensure that your paper is clear and flows smoothly from one topic to the next, certain words can be used. Professor Gregory Campbell, from Michigan State University, writes that transition words “show the relationship within a paragraph (or within a sentence) between the main idea and the support the author gives for those ideas” (4). If you do not want to use transition words, you can also connect your ideas by either contrasting ideas by writing something similar to “Unlike in the first paragraph, the second paragraph...” or by comparing ideas like I did at the beginning of this paragraph. Transitions within your paragraph are just as crucial to the overall
In-Text Citations

Author Unknown

If you cannot find an Author, cite with the Article’s Title. If it is long, shorten it to the first word or so.

If you are using a block quote,

Block Quote

must be cited. The last kind of quoting I will discuss will be block quoting, which is a method that should be used only out of necessity and only in already long papers. A Writer’s Reference suggests:

Long quotations should be introduced by an informative sentence, usually followed by a colon. Quotation marks are unnecessary because the indented format tells reader that the passage is taken word-for-word from the source. Notice that at the end of an indented quotation the parenthetical citation goes outside the final mark of punctuation. (Hacker 381-382)

Use if 4 or more lines of quoted text. Double Spaced. No Indent, offset the quoted text by 1-inch separating the quote from the signal phrase with a colon (:). Your citation will come at the end of your quote with the period coming before your citation.

Each of your in-text citations will correspond to an entry in your Works Cited page.

Example:

In-text: Legal scholar Jay Kesan states, "..." (312).

Citation:


All outside information that you bring to your paper needs to have a citation. Depending on the length of the quote from your source, i.e., 4+ lines, your formatting will change.

into a formula that is not universally suitable for college-level writing. The actual format of your paper will occasionally be limited by the style—such as APA or Chicago—so be sure to double check before breaking any standard structure. Essentially, MLA makes “it easier for readers to navigate and comprehend a text by providing familiar cues when referring to sources and borrowed information” (“Welcome”). Other than how your sources are cited, MLA has very few restrictions.

The last thing that needs to be covered is how to use your quotes. Using information from sources is a great way to lend your paper an overall authority, essentially using experts’
In-Text Citations: Multiple Authors

Works with One or Two Authors

Name the authors in a signal phrase, as in the following example, or include their last names in the parenthetical citation:

Example:

Kizza and Ssanyu note that “employee monitoring is a dependable process of electronically recording all employee activities at work” and elsewhere (2).

-OR-

One study noted that “employee monitoring is a dependable process of electronically recording all employee activities at work” (Kizza and Ssanyu 2).

Works with Three or More Authors

Name all of the authors or include only the first author’s name followed by “et al.” (Latin for “and others”). The format used should match the format in your Works Cited entry.

Example:

The study was extended for two years, and only after results were reviewed by an independent panel did the researchers publish their findings (Blaine et al. 35).
In-Text Citations: Unique Situations

Repeated Citations from the Same Source

After mentioning the author’s name at the beginning of your paper, you can just include the page numbers in the parenthetical citations.

Example:

In Susan Glaspell’s short story “A Jury of Her Peers,” [...] the male investigators are “snoopin’ round and criticizin” her kitchen (191).

Indirect Source

If you use a source quoted in another source, begin the parenthetical citation with the abbreviation “qtd. in.”

Example:

According to Bill Coleman, an executive at Salary.com, “Personal Internet use and casual office conversations often turn into new business ideas or suggestions for gaining operating efficiencies” (qtd. in Frauenheim).

Use Frauenheim’s citation information in your Works Cited page.

One-Page Source

MLA does not require a page number for a one page source, but including the page number is still recommended.

Mention the author in the signal phrase and the page number at the end.

Example:

Anush Yegyazarian reports that in 2000 the National Labor Relations Board Office helped win restitution for two workers who had been dismissed because their employers were displeased by the employees’ emails about work-related issues (62).
Hanging Indent settings:

1. Open the Paragraph Settings box.
2. Everything remains the same except for under the dropdown labeled Special, change it from First Line to Hanging.

Example:
Author last name, First Name. Book Title. Publisher Name, Year Published.

Notice above how every line after the first is indented once—a hanging indent.

Ruler:

1. At the top of the document, move the upper triangle back to its original placement.
2. Click and drag the hourglass to the 4th measurement marker.
3. Move the upper triangle only back to its original place.
Works Cited Page

1. Insert → Pages → Page Break
2. Home → Paragraph → Center.
3. Type: Works Cited at the top of your page, **centered**
4. On the next line, justify your text back to the **left**.
5. Utilize hanging indents for each of your citations (see Hanging Indent slide).
6. Alphabetize your entries.
7. Follow all MLA Citation guidelines (see following slides).
Citations: Books (in print)

Books with One Author
Author’s Last Name, First Name. Title of Book in Italics. Publisher Name, Year of Publication.

Example:

Books with Two Authors
1st Author Last Name, 1st Author First Name, and 2nd Author First Name, 2nd Author Last Name. Title of Book in Italics. Publisher Name, Year of Publication.

Example:

Books with Three or More Authors
1st Last Name, 1st First Name, et al. Title of Book in Italics. Publisher Name, Year of Publication.

Example:

Capitalize all words in book titles and subtitles except prepositions (in, of, etc.) and articles (a, an, the) – unless the preposition/article is the first word or the first word after a colon.
Ex: The Magic of Narwhals: Mythical Unicorns of the Sea.

Separate multiple authors’ names with commas or “and” (see examples).

Avoid using automatic citation resources like EasyBib or others like it. They may be outdated, incomplete, or incorrect. Always double check your citations with the Writer’s Reference Handbook, the Writing Center, or your professor’s guidelines.
Citations: Books (cont’d)

Book with Corporation/Organization as Author

Corporation or Organization Name. Title of Book in italics. Publisher Name, Year Published.

Example:


Chapter/Section of eBook (Online Book)

Author Last Name, First Name. “Title of Chapter/Section.” Title of Book in Italics. Publisher Name, Year Published. Website Name, Website Publisher (if different from website name), Location (URL without http://).

Example:


Capitalize all words in book titles and subtitles except prepositions (in, of, etc.) and articles (a, an, the) – unless the preposition/article is the first word or the first word after a colon.

Ex: The Magic of Narwhals: Mythical Unicorns of the Sea.

Separate multiple authors’ names with commas or “and” (see examples).

Avoid using automatic citation resources like EasyBib or others like it. They may be outdated, incomplete, or incorrect. Always double check your citations with the Writer’s Reference Handbook, the Writing Center, or your professor’s guidelines.
Citations: Books (cont’d)

Selection from an Anthology

Author of Selections’ Last Name, First Name.
“Title of Selection.” Title of Anthology in Italics, edited by First Name(s) of Editor(s) Last Name(s) of Editor(s) (normal order), Publisher Name, Year of Publication, Page Numbers of Selection.

Example:

Introduction, Preface, Foreword or Afterword

Author of Foreword Last Name, First Name.
Foreword [or Introduction, Preface, Afterword]. Book Title, by Book Author First Name Last Name, Publisher Name, Year Published, Pages of Book Section.

Example:

Edition Other Than the First

Author Last Name, First Name. Title of Book in Italics. Edition #, Publisher Name, Year of Publication.

Example:

Capitalize all words in book titles and subtitles except prepositions (in, of, etc.) and articles (a, an, the) – unless the preposition/article is the first word or the first word after a colon. Ex: The Magic of Narwhals: Mythical Unicorns of the Sea.

Separate multiple authors’ names with commas or “and” (see examples).

Avoid using automatic citation resources like EasyBib or others like it. They may be outdated, incomplete, or incorrect. Always double check your citations with the Writer’s Reference Handbook, the Writing Center, or your professor’s guidelines.
Citations: Peer Reviewed Journal Article

Online Peer Reviewed Journal Article

Author’s Last Name, First Name. “Title of Article.”
Journal Title in Italics, vol. #, no. #, Publisher (if available), Date Published, p. # or pp. #--#, DOI (if available) or stable URL.

Example:

Database Peer-Reviewed Journal Article

Author’s Last Name, First Name. “Title of Article.” Journal Title in Italics, vol. #, no. #, Date Published, p. # or pp. #--#, DOI (if available) or Stable URL.

Example:

Capitalize all words in book titles and subtitles except prepositions (in, of, etc.) and articles (a, an, the) – unless the preposition/article is the first word or the first word after a colon.
Ex: The Magic of Narwhals: Mythical Unicorns of the Sea.

Separate multiple authors’ names with commas or “and” (see examples).

Avoid using automatic citation resources like EasyBib or others like it. They may be outdated, incomplete, or incorrect. Always double check your citations with the Writer’s Reference Handbook, the Writing Center, or your professor’s guidelines.
Citations: Websites

Entire Website

Title of Website in Italics. Name of Sponsoring Organization, day month year published or last update date, URL (without http://).

Example:


Short Work from Website

Author's Last Name, First Name (if given). “Title of Short Work.” Title of Larger Website, Sponsoring Organization, day month year published or last update date, URL.

Example:


MLA Style calls for a sponsor or a publisher for most online sources. If a source has no sponsor, publisher, or page number, skip that information.

Capitalize all words in book titles and subtitles except prepositions (in, of, etc.) and articles (a, an, the) – unless the preposition/article is the first word or the first word after a colon.

Ex: The Magic of Narwhals: Mythical Unicorns of the Sea.

Separate multiple authors’ names with commas or “and” (see examples).
Citations: Online Periodical

Author's Last Name, First Name. “Title of Article in Quotations.” Newspaper, Journal, or Magazine Name in Italics, Day Month Year Published, URL (without http://).

Example:


Capitalize all words in book titles and subtitles except prepositions (in, of, etc.) and articles (a, an, the) – unless the preposition/article is the first word or the first word after a colon.

Ex: The Magic of Narwhals: Mythical Unicorns of the Sea.

Separate multiple authors' names with commas or “and” (see examples).

MLA Style calls for a sponsor or a publisher for most online sources. If a source has no sponsor, publisher, or page number, skip that information.
Online Video

Videographic's Last Name, First Name. "Video Title in Quotes."

Title of Website in Italics, Sponsor (if not the same as website title), Upload Date, URL (without http://).

Example:

Movie (DVD)

"Title of Show in Quotations." Movie or Show Title in Italics, created by/ directed by/ etc., performance by or narrated by full name, episode #, Distributor, Year Released, disc #.

Example:

Capitalize all words in book titles and subtitles except prepositions (in, of, etc.) and articles (a, an, the) – unless the preposition/article is the first word or the first word after a colon.

Ex: The Magic of Narwhals: Mythical Unicorns of the Sea.

Separate multiple authors' names with commas or "and" (see examples).

Avoid using automatic citation resources like EasyBib or others like it. They may be outdated, incomplete, or incorrect. Always double check your citations with the Writer’s Reference Handbook, the Writing Center, or your professor’s guidelines.
Citations: Media - Images

Online Artwork

Artist’s Last Name, First Name. Piece’s Name in Italics.
Year Created, Where the Piece is Located. Website
Title in Italics, Publication date, URL (without http://).

Example:

Picasso, Pablo. Guernica. 1937, Museo Reina Sofia,
Madrid. Museo Nacional Centro de Arts Reina Sofia,

Artwork Found in Book

Artist’s Last Name, First Name. Piece’s Name in Italics. Year
Created, Where the Piece is Located. Book Title in
Italics, Version, Number, Publisher, Publication Date,
Page Number/s (p. # or pp. #–#).

Example:

Picasso, Pablo. Guernica. 1937, Museo Reina Sofia,
Madrid. The Humanistic Tradition, 6th ed., book 6,

Capitalize all words in book titles and subtitles except
prepositions (in, of, etc.) and articles (a, an, the) –
unless the preposition/article is the first word or the first
word after a colon.
Ex: The Magic of Narwhals: Mythical
Unicorns of the Sea.

Separate multiple authors’ names with commas or
“and” (see examples).

Avoid using automatic citation resources like EasyBib or others like it.
They may be outdated, incomplete, or incorrect. Always double check
your citations with the Writer’s Reference Handbook, the Writing
Center, or your professor’s guidelines.
Congratulations!

For additional help, please visit the
Melbourne Writing Center,
located in Building 2, Room 125.

321-433-5605
melbournewritingcenter@titans.easternflorida.edu

Things to Remember:

• Times New Roman, 12 pt.
• Double-spaced throughout
• Left Justified, 1-inch margins
• 0.5-inch Indentation
• Last Name and Page Number in the Header of each page
• In-text citations for every source used.
• Works Cited on its own page
• Citations in Alphabetical Order with a 0.5-inch Hanging Indent